
Welcome

TurboZIP Express is designed to make working with ZIP and CAB archive files easier. Its intuitive interface 
enables you to use it immediately, without extensive training. A five-topic, five-minute "How To" tutorial, complete 
with illustrations, is included to show you just how simple it can be.
Complete explanations of each function, along with special tips and tricks, are included in this help file. If you ever 
have a question about TurboZIP Express, press the Help button or your F1 key for immediate, context-sensitive 
assistance. 
A complete features list is included, also with links to helpful, related topics. However, if you are new to TurboZIP 
Express and perhaps even ZIP and CAB (cabinet) files, we suggest you follow the series of  buttons that lead 
you through a few brief, illustrated orientation topics. It will only take a few short minutes, and provide you with the 
immediate ability to use TurboZIP Express for opening, viewing, extracting, and creating ZIP and CAB files. The 
next page is a hypertext Visual Overview that displays an image of TurboZIP Express with hotspotted areas that 
can quickly orient you to the system.
You can begin by familiarizing yourself with the list of terms used by TurboZIP Express and within this Help file:
· Archives (ZIP and CABinet files) are packages that contain one or more individual files. They are usually 

compressed, which saves disk space and also makes sending them over the Internet or a network much 
quicker.

· ZIP and CAB are two popular archive file formats. While the ZIP format is more popular, CAB files can often 
be more highly compressed. ZIP file format archives have been in use for many years, and are not related to 
any Zip disks or drives you may have heard about.

· When you Open a ZIP or CAB archive file, it is to display the list of files inside it; the individual files are not yet
extracted and available. You can then decide whether we want to extract any or all of them. TurboZIP Express
offers significant advantages by letting you preview files (look at them) without having to go to the trouble of 
extracting them first.

· To restore a file within a ZIP or CAB archive for use as a normal file, we Extract it, expanding it to its true size
and recreating it in a folder.

 This light bulb icon designates special tips and notes in this Help file.

 Please click on the button to proceed to the Visual Overview.



TurboZIP Express Visual Overview
 First "How To" Tutorial Topic 

Click on each of the  stars on this reduced-size image of the TurboZIP Express window to get a quick overview 
of its many features and how to use them. Detailed help is always available from within TurboZIP Express.

To continue your overview of TurboZIP Express, we suggest you browse the very brief, five-step "How To" 
tutorial that follows. You may read through each short topic by following the series of buttons provided.

 First Tutorial Topic - How To Open a ZIP or CAB file



Open a ZIP or CAB file          HOW TO

Next Tutorial Topic 

 Click on the Open button, and then use the file management dialog to choose a ZIP or CAB file.

 

The archive is now open in TurboZIP Express, with all of its contents displayed in the large file window. 

Note: The Toolbar button text option in the Tools menu is off in this view of TurboZIP Express. 
The text labels are shown in a pop-up display if you hover over any button.

You can now VIEW files within the ZIP or CAB file, or EXTRACT one or more to a folder of your choosing.

 Next Tutorial Topic - How To View Files inside a ZIP or CAB file



View Files inside a ZIP or CAB file          HOW TO

Next Tutorial Topic 

 TurboZIP Express offers you the advantage of looking at file(s) inside ZIP or CAB files without extracting 
them.

First, click on a file to highlight it, and then click on the Preview/Back toolbar button.

TurboZIP Express displays it in a separate window. 

Clicking on the Preview/Back toolbar button again returns you to the file listing.

 If you double-click on the file name, the application associated to that file type (example: Microsoft Word for .doc 
files) will be called to display the file. Additional details about the how Preview works are available from the TurboZIP 
Express Preview feature help topic.



 Next Tutorial Topic - How To Extract Files from a ZIP or CAB file



Extract File(s) from a ZIP or CAB file          HOW TO

Next Tutorial Topic 

 When you have decided to extract one or more files from a ZIP or CAB archive, click on the Extract toolbar 
button. (The archive must be already open in TurboZIP Express)

The Select Folder To Extract To window (dialog) appears, so you can choose the folder where you want to put the 
extracted files. 

 

 If you wish, you can create a new folder for the extracted files by typing it in and clicking on the small folder icon 
at the end of the entry box.
When you click on the Extract button, the file(s) that are highlighted in the TurboZIP Express file listing will be 
extracted, or, if no files are highlighted, all of the files will be extracted.

Additional details about the Select Folder To Extract To dialog are available.

 Next Tutorial Topic - How To Create a ZIP or CAB file



Create a ZIP or CAB file          HOW TO

Next Tutorial Topic 

 Click on the New button and move to the folder of your choice using the Create New File dialog. 

Type in the file name (testing.zip or testing.cab, for example), and click Save.

 

The file is now created, but it is "empty" (there are no files within it). The next step is to add files to your newly created
ZIP or CAB file. 

 Next Tutorial Topic - How To Add Files to a ZIP or CAB file



Add Files to a ZIP or CAB file          HOW TO

Go to Feature List 

 When your newly created ZIP or CAB file (or an existing ZIP or CAB file) is open in TurboZIP Express, just 
click on Add to put new files inside the archive.

The Select Files To Add dialog lets you locate and choose one or more files to add to your archive. The help topic for 
the Select Files To Add dialog provides additional details on how to use it.

 
Once you click the Add button, the file(s) are added to the ZIP or CAB file, and the process is complete.

 You can also add all the files in a selected folder by choosing the Add Folder toolbar button or Add Folder from the 
Actions menu.

There are other ways to open a ZIP or CAB file, create one, or add files to an archive. The next page is a list that lists
all the major features of TurboZIP Express.

 Go to Feature List



Feature List
Click to continue on to an explanation of the TurboZIP Express Preview feature 

TurboZIP Express has a wide range of features to satisfy most users. This listing includes hypertext links to 
additional information on the highlighted topics.

Compatibility
- TurboZIP Express is compatible with other ZIP and CAB file programs that use the standard formats. This 
means you can exchange archive files with users of other archiving and unarchiving programs.

Open ZIP, CAB, and self-extracting ZIP (EXE) files 
- TurboZIP can open the most popular archive types.

Preview Files Without Extracting Them 
- highlight a file in the TurboZIP Express list window and click on the Preview button to view dozens of file 
formats within TurboZIP Express.
- double-click on a file in the TurboZIP Express list window to view it using the applications to which it is 
associated.

Edit and Save Files Within ZIP and CAB files
- TurboZIP Express can edit text and certain other file types. Just click on the Update button in the Actions 
menu, and the changes to the file will be saved to the original archived file, all without extracting it.

Integrated ActiveX and ActiveMovie Support - TurboZIP Express can use ActiveX and ActiveMovie components
installed on your system to display selected files.

Drag and Drop
- drag and drop files into existing archives within Windows Explorer-compatible file managers, bypassing the 
TurboZIP Express interface.
- drag and drop files into archives open in TurboZIP Express.

Right-Click Menus in Windows File Manager 
- create new ZIP and CAB files, quickly bypassing the TurboZIP Express interface.
- extract files from ZIP and CAB files.

Right-Click Menus in TurboZIP Express 
- gain quick access to any number of TurboZIP Express operations.

Install Programs Without Extracting Them 
- automatically extract files to a temporary folder, install them, and delete the folder.

Password Protection 
- encrypt and decrypt files in ZIP archives.

Multi-Volume ZIP files 
- create ZIP archives that span multiple diskettes.

Multiple CAB files 
- define CAB file sizes for storage on multiple diskettes.

Custom File Listings
- display as icons or file listings 
- sort by clicking on any header 
- resize and reorder columns 

Organize Archives using TurboZIP Express 
- move archives to any of a list of defined folders.

Multiple Window Interface - 
- open multiple ZIP and CAB archives and maintain more than one preview window.

 Click to continue on to an explanation of the TurboZIP Express Preview feature



TurboZIP Express Preview

One of the more unique, useful, and convenient features TurboZIP Express offers is the ability to view files in ZIP 
and CAB archives without first extracting the file. Step by step instructions are shown in the How To View Files 
inside a ZIP or CAB file tutorial topic.

If you double-click on a file in the TurboZIP Express listing, the associated program will be activated. For 
example, sample.doc will be displayed in Microsoft Word or WordPad, depending on whether MSWord is installed.
This is very convenient if you require the full features of the program that supports the particular file. However, the 
time and resources required to open the full application can be a drain on both your time and your computer.
TurboZIP Express includes internal support for many common file formats, allowing you to accurately 
display word processing files, images, HTML, etc., and play audio and multimedia files. Your files are accessed 
instantaneously, and displayed within separate TurboZIP Express windows.
If you select a file, and then click on the Preview/Back toolbar button, it can be displayed using TurboZIP 
Express. To return to the file listing, click on the Preview/Back toolbar button again.
You may wish to automate the Preview feature if you are a frequent user. Check off the Automatic Preview option 
in the Preview configuration tab, and when you click on any file in the TurboZIP Express file list window, it will be 
previewed immediately.

When you preview a file, a new window is opened in TurboZIP Express, which remains open until you close it. 
TurboZIP Express uses a multiple window interface, like many other Windows applications, so you can arrange and 
access all the different windows, as is illustrated in this image. Refer to the Multiple Window Interface help topic for 
details on how to use this feature.

 You can edit certain files in TurboZIP Express and save the results to the file within the ZIP or CAB file. Use the file
type-specific menu items, and then choose Update from the Actions menu.

 You can also edit image files in external programs and then update the file in the archive. First, open a preview 
window to display the image. Then, double-click to open it in the default image editing program and make your 
changes. You can copy the end result to the Windows Clipboard, and then paste it into the open preview window in 
TurboZIP Express, and then choose Update from the Actions menu. 



TurboZIP supports a range of popular file formats. If an unusual file type is not supported, and instead 
displayed in hexidecimal format, you can double-click on it to open it in the application associated with that file 
type on your system.

Text - RTF, TXT, Word 6, full hex ASCII, HTML source code, common ASCII (text) files
Images - BMP, DIB, RLE, GIF (including animated), JPG
Multimedia - AVI, WAV, MID, RMI
ActiveX - PPT, XLS, DOC, DWF, PDF, HTML
ActiveMovie - MP3, MPEG (.mpg, .mpeg, .mpe, .mpa, .enc), MOV
Misc ICO, CUR, ANI,    
Unknown file types are displayed in simple hexadecimal format.

 HTML is shown as text source code or displayed as in web page format based on the setting in the Preview 
configuration item: HTML Options; Use ActiveX.



Performing Common ZIP and CAB Operations

TurboZIP Express offers more than one way to perform common ZIP and CAB file operations. 

The  TurboZIP Express and 

 Windows Explorer icons indicate from which interface the operation can be conducted.

Open a ZIP or CAB file in TurboZIP Express
 Open toolbar button; Open entry in the File menu. 

Extract file(s) from a ZIP or CAB file

 Extract toolbar button; Extract or Extract All entry in the Actions menu. 

 Right click on file(s) in the list window in TurboZIP Express and choose Extract or Extract All from the menu.

 Right click on the file in Windows Explorer and select an Extract To option from the menu. See Explorer Context 
Menus for details.

Create ZIP or CAB files

 New toolbar button; New entry in the File menu. 

 Right click on any file(s) and select an Add To option from the menu. See Explorer Context Menus for details.

Add files to an existing ZIP or CAB file

 Add toolbar button; Add entry in the Actions menu. 

 Drag file(s) to an existing ZIP or CAB file. See Drag and Drop for details.

 
 

 Drag file(s) from Windows Explorer into the file listings of a ZIP or CAB currently open in TurboZIP Express.

Add folder(s) to an existing ZIP or CAB file

 Add Folder toolbar button; Add Folder entry in the Actions menu. 

 Drag folder(s) to an existing ZIP or CAB file. 

 
 

 Drag folders(s) from Windows Explorer into the file listings of a ZIP or CAB currently open in TurboZIP Express.



Drag and Drop

TurboZIP Express supports drag and drop within Windows Explorer, TurboBrowser, and other compatible file 
management programs.
Add file(s) to an existing ZIP or CAB file by dragging and dropping them on the archive file within Windows 

Explorer, TurboBrowser, and other Explorer-compatible file managers.
When you do so, the Compression, Compression Filters, and Folders configuration tabs are displayed, so you 

can make any changes necessary, or click OK to finish the operation.
 You can Add the files immediately, and not be interrupted by the configuration options, by checking the 

Drag and drop files into archive without showing configuration dialog option in the Program Options 
configuration tab.

Add file(s) to an existing ZIP or CAB file open in TurboZIP Express by dragging and dropping them into the 
TurboZIP Express window.

Add folder(s) to an existing ZIP or CAB file open in TurboZIP Express by dragging and dropping them into the
TurboZIP Express window.

Open a ZIP or CAB file in TurboZIP Express by dragging and dropping it from Windows Explorer, TurboBrowser,
and other compatible file management program, to the TurboZIP Express title bar.

 See the Explorer_Context Menus Help file topic for other ways to quickly perform other ZIP and CAB operations 
from within Windows Explorer.



Explorer Context Menus

TurboZIP Express delivers some very convenient and useful tools to your right mouse button, whether you use 
Windows Explorer (shown), TurboBrowser, or any other Explorer-compatible file management tool. These menu 
items let you open or add to a ZIP or CAB file, or create a ZIP file, very quickly, bypassing the use of the TurboZIP 
Express window.

When you right click on any file that is not a ZIP or CAB file, the following menu is displayed. 
Please note that folder and file names are those of sample files; they would be replaced by your path and file 
name.

Add To... - Display the Select Archive To Add To dialog so you can create a new ZIP or CAB file or locate an existing 
archive to add the selection to.
Add To 'C:\FolderName\sample.txt.zip' - Immediately create a ZIP file using the name of the file selected. 

Add To 'C:\FolderName\sample.txt.zip' + Options - Prepare to create a ZIP file using the name of the file 
selected, but first display the Compression, Compression Filters, and Folders configuration tabs for final fine-
tuning of options.

 If you select multiple files, the file name offered will be "Files From 'FolderName'.zip". In both cases, this 
convenient step can create the new ZIP file, and you can quickly rename the file using normal Windows methods.

Add To 'C:\FolderName\sample.txt.cab' - Immediately create a CAB file using the name of the file selected.
Add To 'C:\FolderName\sample.txt.cab' + Options - Prepare to create a CAB file using the name of the file 

selected, but first display the Compression, Compression Filters, and Folders configuration tabs for final fine-
tuning of options.

 If you select multiple files, the file name offered will be "Files From 'FolderName'.cab". In both cases, this 
convenient step can create the new CAB file, and you can quickly rename the file using normal Windows methods.

When you right click on an existing ZIP or CAB file, the following menu is displayed. 

You can extract the contents of the ZIP or CAB to a folder, or add the file to an existing or new archive, by 
choosing from the following selections:



Extract To... - Open the Select Folder To Extract To dialog so you can choose a folder and optionally access 
configuration choices

Extract To 'C:\FolderName' - Immediately extract all files into the same folder (your folder name will be displayed 
in the menu), along with the chosen ZIP or CAB file.

Extract To 'C:\FolderName' + Options - Extract all files into the same folder (your folder name will be displayed 
in the menu), along with the chosen ZIP or CAB file, but display the Extract Configuration tab first, so its options 
can be reviewed and changed, if necessary.

The following menu items are also displayed, and are explained above. These enable you to add an existing ZIP 
or CAB file to a new ZIP or CAB file. Multiple archives can be placed inside another archive for organizational or 
other purposes, if desired.
Add To... -
Add To 'C:\FolderName\sample (2).zip' -
Add To 'C:\FolderName\sample (2).zip' + Options -
Add To 'C:\FolderName\sample (2).cab' -
Add To 'C:\FolderName\sample (2).cab' + Options -

When you right click on an existing ZIP or CAB file and drag it to a folder, the following menu is displayed:

Extract Here - Immediately extract all files into the folder to which you dragged the ZIP or CAB file.
Extract Here + Options - Extract all files into the folder to whicht you dragged the ZIP or CAB file, but display the 

Extract Configuration tab first, so its options can be reviewed and changed, if necessary.

Note: The Configuration option Put context menu items into a submenu in the Program Options tab was not 
checked off when these screen images were taken. Checking that option shortens the menu list by displaying a 
single TurboZIP Express menu entry that accesses a submenu with all the entries shown. If your context menu 
becomes unmanageable because of many other entries, you may want to consider this option; otherwise, having 
all the TurboZIP Express options at your fingertips is the most convenient, and default, option.



File Listings Context Menus

When you right click in the TurboZIP Express file listing, a different set of menu items will display, depending on 
where you click. These are provided as quick and convenient alternatives to clicking on menu entries or toolbar 
buttons, and duplicate those functions. 



Organizing Archive Files

Organizing your archive files, if you download, create, and receive many ZIP and CAB files, can be assisted by 
using specific TurboZIP Express features. 
The key, as with organizing all types of files, can be creating descriptive folders and placing archives in them, 
rather than leaving them in a massive c:\download or other folder.
Use TurboZIP Express to identify and sort archives:

The AutoScan selection under the Tools menu can open all the archives in a selected folder, making their 
content available in TurboZIP Express.

You can use the Preview feature to help identify ZIP and CAB files with non-descriptive file names.
The Move To and Move To Folder toolbar and File menu entries can be used to move an archive to the 

appropriate folder. It's easy to add to your list of preferred folders by using the Move To Folder tab from the 
Configuration entry in the Tools menu.



Batch Extraction

You can extract more than one ZIP or CAB file with TurboZIP Express by using the Batch Extraction entry, 
accessible from the Tools menu. 
When you click on the menu item, a conventional file selection window lets you pick each of the files you want to 
extract. You can use the usual Windows file selection methods to choose individual files in the file list window: 
Hold down the Control Key to click on individual files, to add to your selected group. Hold down the Shift Key to 
select a range of files, clicking on the first, then the last.
After you have selected files and click OK, you will be asked if you want to open them in TurboZIP Express as well
(yes), or just want to extract them to the folder you have designated (no). 



Password Protection

TurboZIP Express can apply standard encryption to ZIP archive files to help protect their contents. It is necessary 
to enter a password to decrypt the file(s) that are password-protected. This process uses industry-standard ZIP 
encryption, and is compatible with other products that use the standard method.
Encrypting File(s):
When the Password Protection box is checked off in the Compression configuration tab, TurboZIP Express will 
pause and display a Password dialog, where you may enter a password whenever you add files to a ZIP archive. 
It also provides a button to bypass encryption for that particular operation, if desired.
Decrypting File(s):
TurboZIP Express senses when file(s) within an archive are encrypted, and will display an Enter Decryption Code 
dialog so you may enter the proper password. It is not necessary to make any configuration changes for TurboZIP 
Express to handle these files.

 Each file in the ZIP archive is encrypted separately, not the entire ZIP file. If you add new password protected 
file(s) to an existing ZIP archive, the existing files within the ZIP will not also be encrypted. You may also add file(s) in 
separate operations and apply different passwords to different files in the same ZIP archive.



Multiple Window Interface

The standard multiple window interface is used by TurboZIP Express. This allows you to open multiple archives as
well as a large number of previews of files.
The usual selection of options are available from the Window menu, to let you cascade or tile the interface with all 
of the open windows. In addition, TurboZIP Express offers a Close All Preview command to eliminate windows that
may no longer be necessary.



File
Create New ZIP and CAB files or Open existing 
ones from selections in this menu. You can 
also Print listings, activate your E-Mail program 
to Send a file, Copy, Move, and Delete files, as 
well as view information about them.



Edit
Quickly select All files or invert your selection
from this menu item.



View
TurboZIP Express lets you choose the way you want 
to view the contents of ZIP and CAB files. 
Adjust and move the columns to your 
preferences, or change it to a large or small 
icon view, just like in Windows Explorer.



Actions
This is where the action is, with items to Add 
Files or Folders, Extract selected or all the files 
from a ZIP or CAB file, convert ZIPs to CABs 
and vice-versa, and Test them to make sure 
they are ok. 



Tools
Reduce the size of the toolbar and put it on 
any side of your TurboZIP Express window, 
and use special Batch tools to extract or 
E-Mail more than one ZIP or CAB file. 



Window
TurboZIP Express acts just like Microsoft Word 
and other programs that let you open multiple 
windows. All the familiar items are here, to move 
between windows and even cascade or tile them.



Help
Detailed TurboZIP Express Help is always available, 
and you can always press F1 or click on Help to get 
an explanation specific to the window that is open.



New
Use NEW when you want to create a brand new 
ZIP or CAB file. A standard Windows Open box 
appears, ready for you type in a name and 
navigate to the folder where you want to put it.
After you've created a new archive, you click on 
ADD to put the files you want into it.



Open
OPEN a ZIP or CAB file with this toolbar entry. 
After it is open in TurboZIP Express, you can Extract or
View the files that are listed. Access and open
recently used archives from the arrow  button.



Add
It's easy to ADD one or more files to a new or 
existing ZIP or CAB file using this toolbar button. 
The familiar Windows file window lets you choose
the files you want to add to the file that you have 
open.



Add Folder
You can ADD the contents of an entire FOLDER to 
a new or existing ZIP or CAB file by choosing this 
button, and then selecting the folder you want to
be a part of the archive.



Extract
It's easy to EXTRACT a single, more than one, or all 
of the files in a ZIP or CAB file when you click this 
button. A simple window lets you choose the folder 
in which you want to place the files, or lets you 
create a new one.



Remove
Click this selection to REMOVE one or more files
from an existing ZIP or CAB file.



Preview/Back
This is one of the most exciting features of TurboZIP Express. 
You can look at files within a ZIP or CAB file without extracting
them.



Install
You can INSTALL a program within a ZIP or CAB file 
without extracting the files. TurboZIP Express recognizes 
standard Setup and Install .exe files and makes this 
button available. When you click on it, TurboZIP Express 
automatically opens the files into a temporary folder and 
starts the installation process, and deletes the temporary 
files when it is finished. 



Configuration
All of the TurboZIP Express CONFIGURATION choices are 
available from neatly tabbed windows when you select this 
button. You can keep the default choices and never even 
look at these options; however, each configuration page 
offers ways to customize TurboZIP Express to your prefer-
ences and is completely explained in this Help file.



Move To and  Move To Folder
MOVE a ZIP or CAB file from its current location to another.
It's easy to choose a folder and quickly move the archive to
be more organized and enhance your productivity.



Column Headings
You can adjust the column widths and even 
change their order with your mouse, and clicking 
on any heading changes the sort order of the 
file list. And if you prefer an icon-style view, 
make your selection from the View menu.



File Names
See a list of all the files in the ZIP or CAB file,
and use convenient right-mouse menus to access
TurboZIP Express functions, open the file in its
native application, if available, or preview it using
the many file formats TurboZIP Express
supports.



File Sizes and Compression Ratios
Get a clear view of the file sizes, before and 
after compression using ZIP or CAB, as well 
as the percentage of compression.



File Window
The File Window offers a wide range of helpful 
features. Right-clicking on individual files 
brings up menus that are customized for that 
file type. In addition, other menu items 
conveniently duplicate the actions that you 
need most.



Toolbar          

TurboZIP Express offers a toolbar for easy access to its most-used functions. 
New - Create a new ZIP or CAB file.

See How to Create a ZIP or CAB file for details.
Open - Open an existing ZIP or CAB file.

See How to Open a ZIP or CAB file for details.
 Click on the adjacent arrow to access and chose from a list of recently opened files.

Add - Add files to a new or existing ZIP or CAB file.
See How to Add Files to a ZIP or CAB file for details.
Add Folder - Add the contents of a folder to a new or existing ZIP or CAB file. To include subfolders and their 
contents, the Recurse subfolders entry in the Compression configuration tab must be checked off. 

Extract - Extract one, more than one, or all of the files in a ZIP or CAB file.
See How to Extract File(s) from a ZIP or CAB file for details.

Remove - Delete the highlighted file(s).
Use this selection with caution, since files are removed immediately and cannot be recovered.
Note: This toolbar button will be grayed-out (unavailable) when no file(s) are highlighted for deletion.

Preview/Back - Display the highlighted file(s) using the TurboZIP Express viewing capabilities.
Note: This toolbar button will be grayed-out (unavailable) when no file(s) are highlighted for previewing.

Install - Install a program from within a ZIP or CAB file without extracting it. If this toolbar item is available (it is 
grayed out if no installation file is detected), TurboZIP Express will temporarily extract all the files, execute the 
installation, and delete the temporary files when the installation process is completed.
Note: This toolbar button will be grayed-out (unavailable) when no standard install file(s) are found by TurboZIP 
Express.

Configuration - All of the TurboZIP Express configuration choices are available from neatly tabbed windows when
you select this button. You can keep the default choices and never even look at these options; however, each 
configuration page offers ways to customize TurboZIP Express to your preferences and is completely explained 
in this Help file.

Move To - Move a ZIP or CAB file from its current location to another folder. A convenient dialog lets you pick the 
destination folder, and the archive remains open, from its new location, in TurboZIP Express. 

 Move To Folder - Click on the arrow to select from a list of your preferred archive folders. The folders shown 
in this list can be modified from the Move To Folder tab, accessible from the Configuration menu item under 
Tools.

You can change the appearance 
and position of the toolbar by 
selecting the Toolbar item under 
the Tools menu:
Click to uncheck the Button Text 
item; this significant reduces the 
size of the toolbar and displays 
smaller icons only, eliminating the 
text labels.
Select any of the other choices to 
position the toolbar at the left, 
right, top, or bottom.
You can remove the Toolbar, and 
use menu items instead, by 
deselecting Toolbar under the 
View menu.



File           MENU

Note: The contents of the File menu will change depending on whether a file listing or preview window is being 
highlighted. As a result, some of these entries will not be applicable and will not appear.
New - Create a new ZIP or CAB file.
Open - Open an existing ZIP or CAB file.
Print - Print a listing of files from the currently visible, open ZIP or CAB file.
Print Preview - Preview a listing of files from the currently visible, open ZIP or CAB file, zoom in or out, and print 
the listing. 
Print thru Application - Use the application associated, by Windows, to this file type, to print this file.
Print Setup... - Access the standard printer dialog to choose and configure a printer.

Send Mail - Begin the process of sending the ZIP or CAB file as an email attachment. You must have MAPI, a 
standard component of Windows, and a compatible e-mail program installed in order to take advantage of this 
feature. Not all e-mail programs are MAPI-compatible; consult your documentation.

Copy To... - Make a copy of one or more files in another folder.
Move To... - Move a ZIP or CAB file from its current location to another folder. A convenient dialog lets you pick the

destination folder, and the archive remains open, from its new location, in TurboZIP Express. The Move To 
Folder (below) choice can make the operation even quicker by providing a list of your preferred archive folders.

Move To Folder - You can quickly move an open file to one of your preferred archive folders when you click on 
this option. To add a folder, access the Move To Folder tab from the Configuration entry in the Tools menu.

 See the Organizing Archive Files help file topic for additional information and tips. 
Delete - Erase the entire ZIP or CAB file

 Individual files within a ZIP or CAB can be erased using Remove from the Toolbar or Actions menu.
Properties - Display the properties of the ZIP or CAB file, which includes various file characteristics, including 

sizes, compression ration, dates, and more.

Recently used file list (the file names below are shown as examples). TurboZIP Express remembers the most 
recently used files; clicking on a selection will reopen it.

1 filename.zip
2 C:\download\filenam2.zip
3 A:\test.cab

Exit - Close TurboZIP Express



Edit           MENU

Note: The contents of the Edit menu will change depending on whether a file listing or preview window is being 
highlighted. As a result, some of these entries will not be applicable and will not appear, or the menu may not 
appear at all.

Select all - Click to choose all of the files in the file list window.
Invert selection - This item reverses the current file selection in the file list window.
 You can use the usual Windows file selection methods to choose individual files in the file list window: Hold down 

the Control Key to click on individual files, to add to your selected group. Hold down the Shift Key to select a range of 
files, clicking on the first, then the last.

Copy, Paste, and Clear, standard Windows commands, may also appear.
 You can edit images within archive files and update the file from TurboZIP Express. Open a Preview window for the

file in TurboZIP Express, and also double-click on the file to open it in your default image editor. Make your edits, 
copy it to the Clipboard, and then paste it into the open TurboZIP Express preview window. Click on the Update 
selection in the Actions menu to save the image in the manner in which it is displayed.



View           MENU

The contents of the View menu will change depending on whether a file listing or preview window is being 
highlighted. As a result, some of these entries will not be applicable and will not appear.

Toolbar - toggle the check mark to show or hide the toolbar.
 You can change the toolbar's location and hide the text descriptions to make it smaller by using the Toolbar 

selection under the Tools menu item.
Status Bar - hide or display the status bar by clicking this selection. The status bar is the small section directly below 
the toolbar.

Best Fit Column Width - click to automatically adjust column widths to their current content.
Default Column Width - click to return the sizes to the TurboZIP Express default.
Default Column Order - click to restore the column to their original order.
 You can resize the columns using your mouse; just place your cursor over the line separating any pair of columns, 

and click and drag. You can also change the order of the columns, too. Place your cursor on any column heading, 
click and drag it left or right to the new location.

TurboZIP Express lets you view file listings using options similar to Windows Explorer. The following choices 
define the display, with the Arrange Icons choice of a long list of sort orders. Just click to see the available options.

Large Icons
Small Icons
List
Details
Arrange Icons

Some or all of these items will appear when a window containing previewed image is being highlighted

Image Toolbar - hide or display the toolbar by clicking this selection. The setting will be retained between 
sessions. Hover over any button to have its function pop up.

The remaining options should be self-explanatory. Some changes (rotate and flip options) can also change the file 
in the archive. Click on the Update selection in the Actions menu to save the image in the displayed format.

Scale To Fit
Normal Size
Zoom In
Zoom Out
Rotate to Right
Flip Horizontally
Flip Vertically
Options - 

 Fit image to window



Insert           MENU

This menu appears only when a text file is being displayed in a Preview window. 
You may insert the date and time into a displayed text file, and insert an object into the file. These entries let you 
modify the appearance of the file, and could be suitable if you want to customize the appearance of the file when it
is printed. Some of the changes can be saved to the archived file by choosing the Update menu entry under 
Actions. However, only items supported by the file format can be retained.



Format           MENU

This menu appears only when a text file is being displayed in a Preview window.
These items let you modify the appearance of the text, to enhance readability, and also if you want to customize 
the appearance of the file when it is printed. Some of the changes can be saved to the archived file by choosing 
the Update menu entry under Actions. However, only items supported by the file format can be retained; for 
instance, ASCII text files cannot have font specifications.
Each entry should be self-explanatory.

Font
Bullet Style
Paragraph
Tabs
Increase Font Size
Decrease Font Size



Movie           MENU

This menu appears only when a multimedia file is being displayed in a Preview window.
These entries control the video or audio playback, and are self-explanatory. Certain selections will display, but do 
not apply to audio playback.

Play
Play Reverse
Stop
Home
End
Step Fwrd
Step Back

 You can use these controls to select a specific video frame and copy it to the Windows Clipboard, for use and 
editing in your favorite image program.



Actions           MENU

The contents of the View menu will change depending on whether a file listing or preview window is being 
highlighted. As a result, some of these entries will not be applicable and will not appear.

Add Files - Add files to a new or existing ZIP or CAB file.
See How to Add Files to a ZIP or CAB file for details.

Add Folder - Add an entire folder and its contents to a new or existing ZIP or CAB file. Refer to the Select Folder 
To Add dialog Help topic for details.

Extract - Extract one, more than one, or all of the files in a ZIP or CAB file. The next menu item extracts all of the 
files in the archive regardless of the current selections.
See How to Extract File(s) from a ZIP or CAB file for details.

Extract All - Extract all of the files in a ZIP or CAB file, regardless of the file(s) selected.

Convert - ZIP and CAB files can be converted between formats. When selected, the Select Archive File is 
displayed, allowing you to specify a new file name and location to save the new file. A configure button is made 
available to further refine the nature of the new file.

Recompress - TurboZIP Express can recompress a ZIP or CAB file, so you can make changes in the way the file 
is processed when it is compressed. For example, a ZIP file could possibly be reduced in size, or a CAB file 
saved in multiple, smaller file segments. When a ZIP file is open and Recompress selected, the Compression 
and Folders Configuration) configuration tabs are shown, and when a CAB file is open and Recompress 
selected, the Cabinet File Options Configuration tab is displayed. These are both made available so any 
changes can be made to the nature of the ZIP or CAB file being recompressed.

Comment - You can view, add, edit, or remove a comment within a ZIP file using this entry.

Test - TurboZIP Express will analyze the ZIP or CAB file to confirm its integrity, and advise you of any problems.
Reload - The file display is refreshed and reflects any possible changes.

Remove - Delete the highlighted file(s).
Use this selection with caution, since files are removed immediately and cannot be recovered.

New Hex Window - When a file is being displayed using TurboZIP Express, you can open up a new window and 
view it in hexadecimal format as well.

Back to Archive - Revert to the file listing.

Install - Install a program from within a ZIP or CAB file without extracting it. If this toolbar item is available (it is 
grayed out if no installation file is detected), TurboZIP Express will temporarily extract all the files, execute the 
installation, and delete the temporary files when the installation process is completed.

 TurboZIP Express looks for files with standard install and setup names, and will not be able to detect non-
standard setup .exe files.

Open - Open an existing ZIP or CAB file.
See How to Open a ZIP or CAB file for details.

Preview - Display the highlighted file(s) using the TurboZIP Express viewing capabilities. 
See Preview for details.



Tools           MENU

Batch Extraction… - You can use TurboZIP Express to extract more than one file at the same time. See Batch 
Extraction to learn how this function works.

Batch Send Files… - The Send Mail item in the File menu lets you use TurboZIP Express select a file and use 
your E-Mail program to send files. This selection enables you to select multiple files and send them using your 
MAPI-compatible E-Mail program, such as Outlook Express. The proper Windows components must be installed
for this function to work.

Auto Scan… - This feature lets you choose a folder and automatically open all of the ZIP and/or CAB archives in 
TurboZIP Express, optionally including the contents of subfolders. Additional details are provided in the Auto 
Scan dialog help topic.

Repair Explorer Associations - When installed, TurboZIP Express associates itself with ZIP and CAB files, so 
that when you click on them, TurboZIP Express automatically opens. Sometimes other programs will break that 
connection after they are installed. If this menu item is available (it is not grayed out), it indicates that the 
association has been broken; click it to fix the connection.
You can be sure that TurboZIP Express is always available when you work with ZIP and CAB files by checking 
the Automatically repair TurboZIP Express' file associations option in the Program Options configuration tab.

Create Start Menu Icon - If this menu item is available (it is not grayed out), you can click on it to add a TurboZIP 
Express icon on the main section of the Start Menu.

Create Desktop Icon - If this menu item is available (it is not grayed out), you can click on it to add an icon on 
your desktop for accessing TurboZIP Express.

Repair Start Menu Folder - If the TurboZIP Express is somehow deleted or corrupted, this menu item will become
available (it is not grayed out). Simply click to fix the entry to make TurboZIP Express available from the Start 
Menu.

Configuration - Access the tabbed selection of configuration options from this menu item.
Toolbar

Button Text - You may click to add or remove the check mark that displays or removes the button text on the 
toolbar. Removing it causes the length of the toolbar to be reduced.
Align... - By clicking on any of the four choices, you can place the TurboZIP Express toolbar at the left, right, 
top, or bottom of the window.



Window           MENU

TurboZIP Express is like many other applications that employ multiple windows. Therefore, you can open up more 
than one ZIP and CAB files, and preview multiple files from within different archives. Most of the following menu 
entries should be familiar, or are self-explanatory. Details are provided for window commands unique to TurboZIP 
Express.

New Window
Next
Previous
Cascade
Tile Horizontally
Tile Vertically
Minimize All
Close Active - Close the window that is currently highlighted.
Close All
Close All Preview - Close preview windows, but do not close archive file list windows.

The last section lists open windows; the file names and types are shown as examples. Clicking on any selection 
will bring it to the front of the display or highlight it.

1 ZIP Archive - C:\archives\sample1.zip
2 Cabinet File - C:\archives\sample2.cab
3 filename.gif



Help           MENU

In addition to providing access to this Help file, the About entry displays system and version information.



Configuration Options          

The Configure button allows you to view each of the ten configuration tabs designed to help you fine-tune 
TurboZIP Express to your specific needs. 
The system is pre-configured to satisfy most users, and it is not absolutely necessary to make any changes. 
However, it may be to your advantage to use the browse buttons (above) or the selections below (displayed in 
each Configuration Help screen) to browse through read about each of the available options, to see how they can 
enhance your experiences depending on how you use TurboZIP Express.
 Next Configuration Tab
 All Configuration Options



Program Options           CONFIGURATION

On Startup
When TurboZIP Express is first opened, it can be ready to do whatever you do the most, or simply open an 
empty window ready for your commands. You can make your choice by clicking on one of the following items:     

 Ask whether to open a file or create a new file - Start the session with the special welcome screen that offers 
buttons with choices of New, Open or Cancel.

 Open an existing file - Display the Open file dialog so I can select an archive file.
 Create a new file - Begin the session with the Create New File dialog.
 Open empty window - Just display the TurboZIP Express interface.

 Automatically repair TurboZIP Express' file associations - By default, TurboZIP Express attaches itself with ZIP
and CAB files, so that when you click on them, TurboZIP Express automatically opens. Sometimes other programs 
will break that connection after they are installed. To be sure that TurboZIP Express is always available when you 
work with ZIP and CAB files, check this option, and the system will maintain the connection to those two file types 
every time you open it.

 Open files from Explorer in a new window - When you double-click on a ZIP or CAB file, it will be opened in 
TurboZIP Express. If this option is checked, another instance of TurboZIP Express will be started with the file 
displayed in that copy of the program.

 Drag and drop files into archive without showing configuration dialog - When unchecked, TurboZIP Express 
will display the Compression, Compression Filters, and Folders tabs so you may review the options used when you 
drag and drop a file, to add it to an existing ZIP or CAB file. This step may be bypassed using this option, which 
speeds up the process. 

 Put context menu items into a submenu - TurboZIP Express adds up to six items to the Windows Explorer right 
mouse context menu, depending on the file selected, for your convenience and quick use. When you check this 
option, only one TurboZIP Express item is added that displays all of the available choices when you click it.

 Next Configuration Tab
 All Configuration Options



Interface           CONFIGURATION

Column and sort options
 Show sort direction with arrows - when selected, an arrow is displayed at the top of each column, indicating that

is assorted in ascending or descending order.

 The file listing can be sorted by any header, in ascending or descending order, just by clicking on a header.
 Enable reorderable column headers - You can drag column headings to new positions to customize 

 Columns can be resized by clicking on the line between list headers and dragging them to size.
 Remember each file's column and sort information – when selected, TurboZIP Express will remember the 

column and sort settings for each file you open.    Unchecked, TurboZIP Express will use the same column and sort 
settings for all files you open.

 Reset Column Settings - Click this button to restore the original TurboZIP Express column settings for both order 
and width.

General list options
 Full row select - When a file is selected, the entire line is highlighted, rather than just the file name.
 Show grid lines - This option places a light gray grid in the file listing box, helping to visually separate file lines.
 Enable hover selection - Instead of clicking on a selection in the file listing, this option selects the file beneath 

your cursor after you have paused for a brief time.

Underline options 
These options are self-explanatory, and apply to the file listing in TurboZIP Express.

 Don't underline selected item(s)
 Underline the name of the selected item(s) - This selection is disabled when Full row select (above) is chosen.
 Underline all the rows of the selected item(s)

 Next Configuration Tab
 All Configuration Options



Move To Folder           CONFIGURATION

When you click on Move To Folder in the TurboZIP Express toolbar or File menu item, a selection of your most-
used or preferred folders can be made available for your quick choice. Use the Move To Folder configuration 
dialog to add new entries to your favorites.

Folder Name - Folders available from the Move To Folder function are listed here.
Add - Click to access a file dialog where you can navigate to and choose folders to add to the list.
Remove - Highlight a folder in the list and click Remove to take it off the list.

 Next Configuration Tab
 All Configuration Options



Folders           CONFIGURATION

TurboZIP Express lets you customize its behavior to make ZIP and CAB operations quicker! You can tell it which 
folder to use for opening and creating files, where to add files from, and where to extract files.

Default folder to OPEN files from
TurboZIP Express remembers where you last opened a file and can use that folder, if you take the first choice. 
Or, do you have a favorite or usual place where you keep files, like c:\download? Then select the second option,
and click the button with the ellipse [...] to choose it. Of course, you can always override the suggested folder 
and select your own.

 Last folder where files were opened from
 From: 

Default folder to CREATE new files in
Just like the previous option, you can let TurboZIP Express remember the last folder, or choose your favorite 
folder for creating ZIP and CAB files.

 Last folder where files were created in
 In: 

Default folder to ADD files from
This option lets the default folder be the same as where the archive (ZIP or CAB file) is, or a folder of your 
choice.

 Last folder where files were added from
 Archive's folder
 From: 

Default folder to EXTRACT files to
Each of the first three choices specify the default folder; however, TurboZIP Express will still pause and display 
a dialog to let you choose or create another folder for extraction. The checkbox option can speed your operation
by bypassing the dialog and promptly extracting the files.

 Use last folder where files were extracted to
 Archive's folder
 To: 

 Automatically extract to selected folder - TurboZIP Express will not pause to enable you to change the default 
folder; it will immediately execute the extraction using the default.

Temporary: 
Check off this option to cause TurboZIP Express to use a temporary folder when creating a ZIP archive. 
However, if it is a large backup file, be certain that sufficient disk space is available. TurboZIP Express will use 
your Windows temporary folder unless you prefer another and enter it here. CAB file operations always use the 
Windows temp folder, regardless of this option.

 Next Configuration Tab
 All Configuration Options



Extract           CONFIGURATION

Overwrite options
These important choices tell TurboZIP Express what to do if a file being extracted already exists. It will usually 
tell you, so you can make a decision (the first option) whether you want to replace the existing file with the new 
one. The Extraction Method options (next) can also be considered in conjuction with this option set. 

 Prompt before overwriting files
 Automatically rename extracted files which exist already - (see Automatic rename mask, below)
 Overwrite all existing files
 Do not overwrite existing files

Extraction method
Normally, TurboZIP Express will extract all the files you choose. However, you can make two other choices that 
avoid overwriting newer files and only extract files if they already exist in the destination folder.

 Extract all selected files
 Update: Extract selected files which are newer than existing files or do not exist
 Freshen: Only extract files which are newer than existing files

Automatic rename mask 
Enter %f for File Name, %n for copy number

If you choose to automatically rename files instead of overwriting them (see Overwrite Options, above), you can tell 
TurboZIP Express what method to use to rename it. With sample.txt as an example, the default entry of %f (%n) 
would rename a replacement sample.txt file as sample (1).txt

General Options
Each of these options customizes the behavior of TurboZIP Express to your liking.

 Convert Long File Names to short names - TurboZIP Express will use the usual conventions and shorten long 
file names to the 8.3 character sizes.

 Do not extract files with Long File Names - Files with long file names will be bypassed.
 Restore path - If the path is included in the archive, TurboZIP Express will recreate the folder structure when 

extracting the file(s).
 Add archive name to destination folder - This option will create a folder, within the destination folder you 

choose, named the same as the archive being extracted. 

 Next Configuration Tab
 All Configuration Options



Compression           CONFIGURATION

These options apply only to ZIP archives. CAB file options are set under the Cabinet File Compression and 
Cabinet File Options tabs.
Compression factor 

Enter a compression factor from 0 to 9, 0 meaning no compression and 9 meaning maximum compression.

Compression method
When you add files to an existing ZIP file, these options tell TurboZIP Express what to do if the files being added
are already a part of the ZIP file.

 Add selected files - If files already exist in the ZIP file, they will be overwritten by the new ones.
 Update: Add selected files which are newer than existing files or do no exist
 Freshen: Only add files which are newer than existing files

Subfolders
 Recurse subfolders - Check this item if you want to include the files in the subfolders beneath your selection.

Folder names
It may or may not be necessary or desirable to save the folder or folder structure of the file(s) being included in 
the ZIP archive.

 Don't store folder names
 Store relative path names - This option only stores folder names if files in folders beneath the current folder are 

also being archived; folder names above the current folder are not included.

 The Recurse subfolders selection above must also be chosen for this to be effective.
 Store full path names - If you want to include the complete path above the current folder, choose this option.

Advanced options
 Delete existing files after compressing - This choice can be useful if you want to compress seldom-used files to 

make more room on a drive.
 Add files directly to archive without creating a temporary archive first - TurboZIP Express usually takes the 

safety step of making a temporary file on your drive and then creates the ZIP file; this option bypasses the step for 
maximum speed, if absolutely necessary.

 Set archive modified date and time to the date and time of the newest added item
 Multi-volume on removable media - TurboZIP Express will create multiple files to span more than one diskette if 

the total size of the ZIP file is larger than the diskette on which you are creating the file. See Multi-Volume Options for 
further information about this feature.

 Skip over locked files - TurboZIPExpress will ignore files that are locked, such as those in use by another 
application or a networked user. 

 Password protection - Standard ZIP encryption can be applied to the file(s) being added to an archive. See 
Password Protection for additional encryption information.

 Next Configuration Tab
 All Configuration Options



Compression Filters           CONFIGURATION

These specialized filters can exclude or include certain types of files for being a part of the archive file. This 
feature can be useful in special situations when you want to avoid files, such as temporary (.tmp) files, or perhaps 
include all of a particular file type in a folder, such as .doc. The date filter can similarly be a useful tool so only new 
or updated files are being added to an archive, such as when you are using TurboZIP Express to periodically 
backup files or are transferring files to another PC. 
 No file filtering
 Use exclusion filter

Type the names of file(s) or extension(s) you want to exclude from adding. The specified file(s) will not be 
added to any ZIP files.

Multiple file type extensions should be separated by a semi-colon, for example:
.tmp; .xyz; Aug*.* 
As you can see, wild card designations can be used.

 Use inclusion filter
Type the name of file(s) or extension(s) you want to include when adding files. Only files matching the 
specified filter will be added

See the notes under Use exclusion filter

 Date filter
Only add files modified after the following date below.

Type in or use the controls to change the date, or click the Set Today button.

 Next Configuration Tab
 All Configuration Options



Cabinet File Compression           CONFIGURATION

These options apply only to CAB archives; ZIP file compression options are chosen in the Compression tab.
Subfolders
 Recurse subfolders- Check this item if you want to include the files in the subfolders beneath your selection.

Advanced options
 Delete existing files after compressing - This choice can be useful if you want to compress seldom-used files to 

make more room on a drive.
 Multi-volume on removable media - TurboZIP Express will create multiple files to span more than one diskette if 

the total size of the ZIP file is larger than the diskette on which you are creating the file. 
 Skip over locked files - TurboZIP Express will ignore files that are locked, such as those in use by another 

application or a networked user.

Folder names
 Don't store folder names
 Store relative path names - This option only stores folder names if files in folders beneath the current folder are 

also being archived; folder names above the current folder are not included.

 The Recurse subfolders selection above must also be chosen for this to be effective.
 Store full path names - If you want to include the complete path above the current folder, choose this option.

 Next Configuration Tab
 All Configuration Options



Cabinet File Options           CONFIGURATION

TurboZIP Express will typically make CAB files as large as necessary to accommodate the files chosen. However, 
the archive can be broken into multiple, smaller size files, especially useful when the file(s) are to be transported 
on diskettes or other media, or created to be transmitted via the Internet.

Type in the name and starting number of disk label (optional) 

Enter the name for the disk labels for the CAB file(s). A starting number can also be specified; if multiple CABinet files
are being created, they will be sequentially numbered, beginning with the number you enter. When you specify a 
maximum size for your CABinet files (below), and the data exceeds that space, multiple CABinet files will be created 
to accommodate your data. If only a single CABinet file is being created, then no number will be added to the file 
name.

Select or enter the maximum size of each cabinet file
 

Choose from the predefined sizes, or select Customized and then enter the size in the spaces available.
 This option is not only useful for creating CAB files sized for use with diskettes, but also in cases when smaller, 

multiple files are desired for sending via E-Mail or made available for download.

Enter the reserved space of a cabinet file

If room is necessary for additional setup or other auxiliary files on the target diskette(s), and a standard size is 
selected in the option above, enter the amount of space to reserve in megabytes, kilobytes, or bytes. It will be 
subtracted from the maximum size of each CABinet file as specified above.

Compression

Select a compression method from your choices of None, MSZIP, and LZX, which also allows the choice of levels 
from 15 to 21.

 Compress each file as a single entity which can be accessed independently - In order to attain the very high 
compression ratios possible with CABinet files, when multiple files are compressed into one CAB file, their contents 
are processed so that it is not possible to access a single file without accessing them all. This option changes the 
process so that each file is compressed, and therefore available separately. However, the ultimate compression level 
suffers as a result.

 Next Configuration Tab
 All Configuration Options



Preview           CONFIGURATION

Details on the Preview function are available on the Preview page. These options affect the behavior of TurboZIP 
Express when individual files and specific types are selected.

General options
 Automatic preview - when you click on any file in the TurboZIP Express file listing window, it will be previewed 

immediately.

HTML Options
 Use ActiveX - TurboZIP Express will display HTML files as you would view them in a browser, using ActiveX, a 

component of Windows 98 and Internet Explorer. If you would prefer to view HTML files as text source, or do not 
have ActiveX installed, uncheck this option.

Audio and Animation Options
 Use ActiveMovie - The use of ActiveMovie, an add-in to Windows, can enhance the playback of multimedia files. 

 All Configuration Options



Auto Scan           DIALOG

This dialog appears when Auto Scan is selected from the Actions menu.
TurboZIP Express can automatically open all of the ZIP and/or CAB files in folder(s) you specify.

Enter a folder name for Auto Scan to look in:
Type in a folder name or use the Browse button to open a file dialog to use to select a folder

Enter or add file types for Auto Scan to search:
Use the file type selection arrow at the end of the line to select ZIP and/or CAB files.

 Scan subfolders
If you want to include subfolders and the files within them, check this box.



Comment           DIALOG

This dialog appears when Comment is selected from the Action menu.
This dialog lets you view, edit, add, and delete any existing ZIP comment. 

Set Comment - Save any changes made to the ZIP file.
Cancel - Do not save any changes.

Comments are not supported in the CAB file format, so this function is available only with ZIP files.



Copy To           DIALOG

This dialog appears when Copy To is selected from the File menu.
This dialog allows you to select the destination folder when you are copying a ZIP or CAB file to another folder. 
Simply navigate to the appropriate folder and click on it, or enter the path directly in the entry box. Note that if you 
do manually enter a path, the folder tree above will change to display the folder you have typed in. 
You may create a new folder by typing in a complete path, or adding a folder name to the folder name presently 
shown. When you do so, the New Folder button to the right of the entry box becomes available -- simply click on it 
and the folder will be created.



Create New File           DIALOG

This dialog appears when New is selected from the toolbar or File menu.
This familiar file dialog allows you to create a new ZIP or CAB file. Once the file has been created, you will want to 
click on the Add toolbar button or Add under the Actions menu so you can select and add files to the new archive.

File name: - Enter the name of the ZIP or CAB file you want to create. You can enter the entire file name, with 
the .zip or .cab extension, or click on the box below to specify the file type as .zip or .cab.

Save as type: - Making a selection has two effects: first, it specifies which file types that already exist in the 
folder will be displayed (.zip and .cab; .zip, .cab, or all files). Secondly, it defines the type of file being 
created, if .zip or .cab are selected and no extension is typed in the File name box.



Enter Decryption Code           DIALOG

This dialog appears when one or more files in a ZIP archive are password proected.
This dialog will be displayed so you may enter the password to decrypt password protected file(s). This occurs 
when you are extracting or previewing an encrypted file.
Enter the proper password, and/or click on one of the following choices:
OK - Click to proceed with decryption with the entered password.
Use For All - If multiple password-protected files are in the ZIP archive, each using the same password, click this 

button to avoid re-entering the password for each file.
Skip - Click to bypass this file and proceed to any remaining files.
Skip All - Choose this option to bypass the current and any other password-protected files, but extract any other 

files.
Cancel - Discontinue the extraction process.

 For an overview, refer to the Password Protection Help file topic.



Move To           DIALOG

This dialog appears when Move To is selected from the toolbar or File menu.
This dialog allows you to select the destination folder when you are moving a ZIP or CAB file from one folder to 
another. Simply navigate to the appropriate folder and click on it, or enter the path directly in the entry box. Note 
that if you do manually enter a path, the folder tree above will change to display the folder you have typed in.
You may create a new folder by typing in a complete path, or adding a folder name to the folder name presently 
shown. When you do so, the New Folder button to the right of the entry box becomes available -- simply click on it 
and the folder will be created.



Multi-Volume Options           DIALOG

This dialog appears when you create a ZIP file and choose a removable drive as its destination.
When you create a new ZIP file and direct it to a floppy disk drive, TurboZIP Express prepares for the possibility 
that the new archive may be larger than the diskette's capacity. TurboZIP Express can create Multi-Volume ZIP 
files, which is one archive broken into smaller ZIP file components. 

When TurboZIP Express recognizes that you are creating a ZIP file on a removable disk, a dialog appears offering 
you the following choices so you can decide if you need to keep any files that are currently on the diskette.
 Keep existing files
 Delete existing files
 Format disk
In each case, the size of the file created will be dependent on the amount of space available on the diskette.

 Multiple CAB files can also be created; criteria for CAB files are determined in the Cabinet File Options 
configuration tab.



Open           DIALOG

This dialog appears when Open is selected from the toolbar or File menu or if Batch Extraction is selected from 
the Tools menu.
This standard file dialog allows you to open an existing ZIP or CAB file. 
When accessed from the Batch Extraction menu item in the Tools menu or from the standard Open command, one
or more files can be chosen and opened.

Files of type: - Use the drop down selection to select the types of files you want to make visible: ZIP, CAB, or 
EXE; ZIP; EXE; or All Files.

TurboZIP Express can open self-extracting ZIP files. These are archives with an .EXE extension that 
automatically open when you run them, without the aid of an unarchiving tool. However, you can use TurboZIP 
Express to gain control of where one or more of the files in the archive is extracted, or to preview its contents. If 
you choose an EXE file that is not a self-extracting ZIP file, a message box will advise you. Other products from 
Pacific Gold Coast Corp. can create self-extracting ZIP files; review the ReadMe Help file for additional 
information.

 You can use the usual Windows file selection methods to choose individual files in the file list window: Hold down 
the Control Key to click on individual files, to add to your selected group. Hold down the Shift Key to select a range of 
files, clicking on the first, then the last.



Password           DIALOG

This dialog appears when the Password Protection item is checked off in the Compression configuration tab. It 
applies only to ZIP archives.
Enter the password - Type in the password to encrypt the file(s) being added.
OK - Use the password and proceed to encrypt and add the selected file(s).
Cancel - Cancel the process.
No Password - Do not encrypt the file(s) being added.

 For an overview, refer to the Password Protection Help file topic.



Print Preview           DIALOG

This dialog appears when Print Preview is selected from the File menu.
This special window displays a WYSIWYG view of the file listing that will be produced when you click the Print 
button, so you can preview it without wasting paper.
Additional buttons to move between pages (Next Page, Prev Page) and to view two pages at one (Two Page) are
provided. In addition, Zoom In and Zoom Out buttons let you examine the copy more closely or at a distant 
perspective. 
Regular menu items are removed during this process, and clicking the Close button returns you to the regular 
TurboZIP Express window.



Select Archive File           DIALOG

This dialog appears when Convert is selected from the Actions menu.
This dialog allows you to enter a name and select a folder for the new archive file you are creating as a result of 
converting it from another format.
The Configure button provides access to the Compression, Folders, and Cabinet File Options tabs so you may 
choose different settings for this particular operation. Changed settings are saved and will affect all future 
operations until altered.



Select Archive To Add To           DIALOG

This dialog appears when file(s) are selected and    "add to" is chosen from the Explorer context menu
Use this dialog to select the ZIP or CAB file to which you want to add the selected file(s). 
You can chose from the Files of Type selections to filter the files displayed.
A Configure button is provided to allow you to review and change the settings within the Compression, 
Compression Filters, and Folders configuration options; any changes are saved for future sessions.



Select Files To Add           DIALOG

This dialog appears when Add is selected from the toolbar or Add Files from Actions menu.
You may create a new folder by typing in a complete path, or adding a folder name to the folder name presently 
shown. When you do so, the New Folder button to the right of the entry box becomes available -- simply click on it 
and the folder will be created.
A Configure button is provided to allow you to review and change the settings within the Compression, 
Compression Filters, and Folders configuration options; any changes are saved for future sessions.

 You can use the usual Windows file selection methods to choose individual files in the file list window: Hold down 
the Control Key to click on individual files, to add to your selected group. Hold down the Shift Key to select a range of 
files, clicking on the first, then the last.



Select Folder To Add           DIALOG

This dialog appears when Add Folder is selected from the toolbar or Actions menu.
Use this standard dialog to choose a folder. All of the files within the folder will be added to the new or existing ZIP 
or CAB file.
A Configure button is provided to allow you to review and change the settings within the Compression, 
Compression Filters, and Folders configuration options; any changes are saved for future sessions.

 You should review the Subfolder and Folder names options in the Compression, configuration tab, if you want to 
include folder names and the contents of subfolders within the folder you choose.



Select Folder To Extract To           DIALOG

This dialog appears when Extract is selected from the toolbar or Actions menu.
Use this window to tell TurboZIP Express where you want to place the extracted files.
You may create a new folder by typing in a complete path, or adding a folder name to the folder name presently 
shown. When you do so, the New Folder button to the right of the entry box becomes available -- simply click on it 
and the folder will be created.
A Configure button is provided to allow you to review and change the settings in the Extract configuration tab. Any
changes are saved for future sessions.



TurboZIP Express Setup Wizard

The TurboZIP Express Setup Wizard includes four simple steps that makes installing the program easy.
1. Click NEXT after you've read the welcome screen.
2. Enter your name and company name in the spaces provided.
3. Accept the default folder for the TurboZIP Express files (C:\Program Files\TurboZIP Express) or use the 

browse button and type in a target folder. The installation routine will create it if necessary. TurboZIP 
Express should be installed in its own folder.

4. TurboZIP Express will be installed quickly. The final screen offers you to opportunity to access the 
program's configuration screens. However, the defaults selected for TurboZIP Express are preset so you 
can use the system immediately, so you may click on Use Defaults to proceed. The Configure button 
allows you to preview each of the ten tabs designed to help you fine-tune TurboZIP Express to your 
specific needs. However, this can wait until later, after you have learned all about the system. 

If you want to review your options now, click on the selection below to select any configuration option Help 
page.

 Configuration Options 




